1. INTRODUCTION TO EXCEL- What Is a Spreadsheet?
Introduction to Spreadsheets
Regardless of what type of quantitative analysis you need to do, you can use a spreadsheet to help you maintain data and perform calculations. A spreadsheet is an electronic file that contains a grid of columns and rows used to organize related data and to display results of calculations, enabling interpretation of quantitative data for decision making. A spreadsheet program is a computer application, such as Microsoft Excel, that you use to create and modify electronic spreadsheets.
· Planning for Effective Workbook and Worksheet Design
A worksheet is a single spreadsheet that typically contains descriptive labels, numeric values, formulas, functions, and graphical representations of data.
A workbook is a collection of one or more related worksheets contained within a single file. 
By default, new workbooks contain three worksheets.
An input area is a range of cells containing values for variables used in formulas
An output area is a range of cells containing results based on manipulating the variables.
· Exploring the Excel Window
Excel elements: 
The Name Box is an identifier that displays the address of the cell currently used in the worksheet. You can use the Name Box to go to a cell, assign a name to one or more cells, or select a function.
Cancel appears to the right of the Name Box when you enter or edit data. Click Cancel to cancel the data entry or edit and revert back to the previous data in the cell, if any. Cancel disappears after you click it.
Enter appears to the right of the Name Box when you enter or edit data. Click Enter to accept data typed in the active cell and keep the current cell active. The Enter check mark disappears after you enter the data.
Insert Function: Click to display the Insert Function dialog box, which enables you to search for and select a function to insert into the active cell.
The Formula Bar, the area that appears below the Ribbon and to the right of Insert Function, shows the contents of the active cell. You can enter or edit cell contents here or directly in the active cell. Drag the bottom border of the Formula Bar down to increase the space of the Formula Bar in order to display large amounts of data or a long formula contained in the active cell.
Select All: The square at the intersection of the row and column headings in the top-left corner of the worksheet. Click it to select everything contained in the active worksheet.
Column headings: The letters above the columns, such as A, B, C, and so on.
Row headings: The numbers to the left of the rows are row headings, such as 1, 2, 3, and so on.
Sheet tabs, located at the bottom-left corner of the Excel window, show the names of the worksheets contained in the workbook. Three sheet tabs, initially named Sheet1, Sheet2, and Sheet3, are included when you start a new Excel workbook. You can rename sheets with more meaningful names. To display the contents of a particular worksheet, click its sheet tab.
Sheet Tab Navigation buttons: If your workbook contains several worksheets, Excel may not show all the sheet tabs at the same time. Use the buttons to display the first, previous, next, or last worksheet.
Status bar: Located at the bottom of the Excel window, below the sheet tabs and above the Windows taskbar, the status bar displays information about a selected command or operation in progress. For example, it displays Select destination and press ENTER or choose Paste after you use the Copy command.
Identify columns, rows and cells
The intersection of a column and row is a cell; a total of over 17 billion cells are available in a worksheet. Each cell has a unique cell address, identified first by its column letter and then its row number.
Navigate In and Among Worksheets
The active cell is the current cell.
Navigate through cells with the scroll buttons or the mouse. 
Navigate among worksheets with the sheet tab




· Entering and Editing Cell Data
The four types of data that you can enter in a cell in an Excel worksheet are text; values; dates; and formulas, including functions
Enter Text
Text is any combination of letters, numbers, symbols, and spaces not used in calculations.
Aligns to the left
Enter Values
Values are numbers that represent a quantity or a measurable amount.
Values align to the right
Enter dates
You can enter dates and times in a variety of formats in cells, such as 9/15/2012; 9/15/12; September 15, 2012; or 15-Sep-12. You can also enter times, such as 1:30 PM or 13:30. You should enter a static date to document when you create or modify a workbook or to document the specific point in time when the data were accurate, such as on a balance sheet or income statement.
Dates are values and align to the right
Enter Formulas
Formulas are the combination of cell references, arithmetic operations, values, and/or functions used in a calculation. For Excel to recognize a formula, you must start the formula with an equal sign (=)

2. MATHEMATICS AND FORMULAS

· Using Symbols and the Order of Precedence
Addition  + Subtraction  -  Multiplication  *  Division  /  Exponentiation ^
Start a formula by typing the equal sign (=), followed by the arithmetic expression. Do not include a space before or after the arithmetic operator. To add the contents of cells A2 and A3, enter =A2+A3. The result appears in the cell instead of the formula itself. You can see the formula of the active cell by looking at the Formula Bar.
You should use cell addresses instead of values as references in formulas where possible. 
You may include values in an input area—such as dates, salary, or costs—that you will need to reference in formulas. Referencing these cells in your formulas, instead of typing the value of the cell to which you are referring, keeps your formulas accurate if the values change.
Control the Results with the Order of Precedence
The order of precedence (also called order of operations) is a rule that controls the sequence in which arithmetic operations are performed, which affects the results of the calculation. Excel performs mathematical calculations left to right in this order: Parentheses, Exponentiation, Multiplication or Division, and finally Addition or Subtraction (Please Excuse My Dear Aunt Sally)
· Using Auto Fill
Auto Fill enables you to copy the contents of a cell or a range of cells by dragging the fill handle (a small black square appearing in the bottom-right corner of a cell) over an adjacent cell or range of cells.
Copying Formulas with Auto Fill. After you enter a formula in a cell, you can duplicate the formula down a column or across a row without retyping it by using Auto Fill. Excel adapts each copied formula based on the type of cell references in the original formula.
Completing Sequences with Auto Fill. You can also use Auto Fill to complete a sequence (January …; 5,10,…)
· Displaying Cell Formulas
You might want to display the formulas instead of the calculated results in the cells. The quickest way to display cell formulas is to press Ctrl and the grave accent (`) key, sometimes referred to as the tilde key, in the top-left corner of the keyboard, below Esc. You can also click Show Formulas in the Formula Auditing group on the Formulas tab to show and hide formulas. This is a toggle feature; do the same step to redisplay formula results.

3. WORKBOOK AND WORKSHEET MANAGEMENT

· Managing Worksheets
You should rename the worksheet tabs to reflect the sheet contents so that you, and anyone with whom you share your workbook, will be able to find data.
You can also change the worksheet tab colour to make it stand out. 
You can Insert, Delete, Move, and Copy Worksheets
· Managing Columns and Rows
Insert Cells, Columns, and Rows
After you construct a worksheet, you might need to insert cells, columns, or rows to accommodate new data. When you insert cells, rows, and columns, cell addresses in formulas adjust automatically.
Excel inserts new columns to the left of the current column and new rows above the current row.
Delete Cells, Columns, and Rows
If you no longer need a cell, column, or row, you can delete it. In these situations, you are deleting the entire cell, column, or row, not just the contents of the cell to leave empty cells. As with inserting new cells, any affected formulas adjust the cell references automatically.
Adjust Column Width
After you enter data in a column, you often need to adjust the column width—the number of characters that can fit horizontally using the default font or the number of horizontal pixels— to show the contents of cells.
Numbers appear as a series of pound signs (######) when the cell is too narrow to display the complete value, and text appears to be truncated.
Adjust Row Height
When you increase the font size of cell contents, Excel automatically increases the row height—the vertical measurement of the row. However, if you insert a line break to create multiple lines of text in a cell, Excel might not increase the row height.
Hide and Unhide Columns and Rows
If your worksheet contains confidential information, such as Social Insurance Numbers or salary information, you might need to hide some columns and/or rows before you print a copy for public distribution. When you hide a column or a row, Excel prevents that column or row from displaying or printing. However, the column or row is not deleted.
Excel displays a thicker border between column headings (such as between A and C), indicating one or more columns are hidden, and between row headings (such as between 8 and 10), indicating one or more rows are hidden.
You can hide multiple columns and rows at the same time.
· Selecting, Moving, Copying, and Pasting
Select a Range
A range refers to a group of adjacent or contiguous cells. A range may be as small as a single cell or as large as the entire worksheet. It may consist of a row or part of a row, a column or part of a column, or multiple rows or columns, but will always be a rectangular shape, as you must select the same number of cells in each row or column for the entire range. A range is specified by indicating the top-left and bottom-right cells in the selection.
A border appears around a selected range. Any command you execute will affect the entire range. The range remains selected until you select another range or click in any cell in the worksheet.
Move a Range to Another Location
You can move cell contents from one range to another.
When you move a range containing text and values, the text and values do not change. However, any
formulas that refer to cells in that range will update to reflect the new cell addresses. 
Copy and Paste a Range
You may need to copy cell contents from one range to another. When you copy a range, the original data remain in their original locations. Cell references in copied formulas adjust based on their relative locations to the original data
Use Paste Special
Sometimes you might want to paste data in a different format than they are in in the Clipboard. For example, you might want to copy a range containing formulas and cell references, and paste the range as values in another workbook that does not have the reference cells. If you want to copy data from Excel and paste them into a Word document, you can paste the Excel data as a worksheet object, as unformatted text, or in another format.

4. FORMATTING
· Applying Alignment and Font Options

Alignment refers to how data are positioned in cells. By now, you know that text aligns at the left cell margin, and dates and values align at the right cell margin. You can change the alignment of cell contents to improve the appearance of data within the cells.
Change Horizontal and Vertical Cell Alignment
You can align data horizontally or vertically. 
Horizontal alignment specifies the position of data between the left and right cell margins
Vertical alignment specifies the position of data between the top and bottom cell margins. Bottom Align is the default vertical alignment
Merge and Centre Labels
Select the range of cells across which you want to centre the title, and then click Merge & Center in the Alignment group on the Home tab. Any data in the merge area are lost, except what is in the far left cell in the range. Excel merges the selected cells together into one cell, and the merged cell address is that of the original cell on the left. The data are centred between the left and right sides of the merged cell.
If you merge too many cells and want to split the merged cell back into its original multiple cells, click the merged cell, and then click Merge & Center.Unmerging places the data in the top-left cell.
Increase and Decrease Indent
To offset labels, you can indent text within a cell
Wrap Text
Sometimes you have to maintain specific column widths, but the data do not fit entirely. You can use wrap text to make data appear on multiple lines by adjusting the row height to fit the cell contents within the column width.
Apply Borders and Fill Colour
You can apply a border or fill colour to accentuate data in a worksheet. A border is a line that surrounds a cell or a range of cells.You can use borders to offset particular data from the rest of the data on the worksheet.
Fill color is a background colour that displays behind the data. You should choose a fill colour that contrasts with the font colour
· Applying Number Formats
Values appear in General format (i.e., no special formatting) when you enter data. You should apply number formats based on the type of values in a cell. Changing the number format changes the way the number displays in a cell, but the format does not change the number’s value.
Number formats
General: A number as it was originally entered. Numbers are shown as integers (e.g., 12345), decimal fractions (e.g., 1234.5), or in scientific notation (e.g., 1.23E+10) if the number exceeds 11 digits.
Number: A number with or without the 1000 separator (e.g., a comma) and with any number of decimal places. Negative numbers can be displayed with parentheses and/or red.
Currency: A number with the 1,000 separator and an optional dollar sign (which is placed immediately to the left of the number). Negative values are preceded by a minus sign or are displayed with parentheses or in red. Two decimal places display by default.
Accounting: A number with the 1,000 separator, an optional dollar sign (at the left border of the cell, vertically aligned within a column), negative values in parentheses, and zero values as hyphens. Two decimal places display by default.
Date: The date in different ways, such as March 14, 2012; 3/14/12; or 14-Mar-12.
Time: The time in different formats, such as 10:50 PM or 22:50 (24-hour time).
Percentage: The value as it would be multiplied by 100 (for display purpose), with the percent sign. The default number of decimal places is zero if you click Percent Style in the Number group or two decimal places if you use the Format Cells dialog box. However, you should typically increase the number of decimal points to show greater accuracy.
Fraction: A number as a fraction; appropriate when no exact decimal equivalent exists. A fraction is entered into a cell as a formula such as =1/3. If the cell is not formatted as a fraction, you will see the results of the formula.
Scientific: A number as a decimal fraction followed by a whole number exponent of 10; for example, the number 12345 would appear as 1.23E+04. The exponent, +04 in the example, is the number of places the decimal point is moved to the left (or right if the exponent is negative). Very small numbers have negative exponents.

Text: The data left-aligned; is useful for numerical values that have leading zeros and should be treated as text, such as postal codes or phone numbers. Apply Text format before typing a leading zero so that the zero displays in the cell.
Special: A number with editing characters, such as hyphens in a Social Insurance Number.
Custom: Predefined customized number formats or special symbols to create your own customized number format.

The Number group on the Home tab contains commands for applying Accounting Number Format, Percent Style, and Comma Style numbering formats.
Increase and Decrease Decimal Places
After applying a number format, you may need to adjust the number of decimal places that display. An entire column of monetary values formatted in Accounting Number Format, Excel displays two decimal places by default. If the entire column of values contains whole dollar values and no cents, displaying .00 down the column looks cluttered. You can decrease the number of decimal places to show whole numbers only.

5. PAGE SETUP AND PRINTING

· Selecting page setup options
Page setup commands
Margins: Displays a menu to select predefined margin settings. The default margins are 1.9 cm (0.75") top and bottom and 1.8 cm (0.7") left and right. You will often change these margin settings to balance the worksheet data better on the printed page. If you need different margins, select Custom Margins.
Orientation: Displays orientation options. The default page orientation is portrait, which is appropriate for worksheets that contain more rows than columns. Select landscape orientation when worksheets contain more columns than can fit in portrait orientation. For example, the OKOS worksheet might appear better balanced in landscape orientation because it has eight columns.
Size: Displays a list of standard paper sizes. The default size is 21.59 cm by 27.94 cm (8.5" by 11"). If you have a different paper size, such as legal paper, select it from the list.
Print Area: Displays a list to set or clear the print area. When you have very large worksheets, you might want to print only a portion of that worksheet. To do so, select the range you want to print, click Print Area in the Page Setup group, and select Set Print Area. When you use the Print commands, only the range you specified will be printed. To clear the print area, click Print Area, and select Clear Print Area.
Breaks: Displays a list to insert or remove page breaks.
Background: Enables you to select an image to appear as the background behind the worksheet data when viewed onscreen (backgrounds do not appear when the worksheet is printed).
Print Titles: Enables you to select column headings and row labels to repeat on multiple-page printouts.
Specify Page Options
The Page Setup dialog box organizes options into four tabs: Page,Margins, Header/Footer, and Sheet. All tabs contain Print and Print Preview buttons.
The Page tab contains options to select the orientation and paper size. In addition, it contains scaling options that are similar to the options in the Scale to Fit group on the Page Layout tab. You use scaling options to increase or decrease the size of characters on a printed page, similar to using a zoom setting on a photocopy machine. You can also use the Fit to option to force the data to print on a specified number of pages.
Specify Margins Options
The Margins tab contains options for setting the specific margins. In addition, it contains options to centre the worksheet data horizontally or vcertically on the page. To balance worksheet data equally between the left and right margins, Excel users often centre the page horizontally.
Create Headers and Footers
The Header/Footer tablets you create a header and/or footer that appear at the top and/or bottom of every printed page. You can use headers and footers to provide additional information about the worksheet
Select Sheet Options
The Sheet tab contains options for setting the print area, print titles, print options, and page order. May choose to display the grid & the row/column headers. 
· Printing a Worksheet
Use print preview mode
This mode helps you see in advance if the data are balanced on the page or if data will print on multiple pages. The bottom of the Backstage view indicates how many total pages will print. If the settings are correct, you can specify the print options. If you do not like how the worksheet will print, click the Page Layout tab so that you can adjust margins, scaling, column widths, and so on until the worksheet data appear the way you want them to print.

6. FORMULAS AND FUNCTIONS- Performing Quantitative Analysis
Formula Basics
· Using Semi-Selection to Create a Formula
To decrease typing time and ensure accuracy, you can use semi-selection, a process of selecting a cell or range of cells for entering cell references as you create formulas. Semi-selection is often called pointing because you use the mouse pointer to select cells as you build the formula
· Using Relative, Absolute, and Mixed Cell References in Formulas
Excel uses three different ways to reference a cell in a formula: relative, absolute, and mixed.
When you create an original formula that you will copy to other cells, ask yourself the following: Do the cell references need to adjust for the copied formulas, or should the cell references always refer to the same cell location, regardless of where the copied formula is located?
Use a Relative Cell Reference
A relative cell reference indicates a cell’s relative location, such as two rows up and one column to the left, from the cell containing the formula.When you copy a formula containing a relative cell reference, the cell references in the copied formula change relative to the position of the copied formula. Regardless of where you copy the formula, the cell references in the copied formula maintain the same relative distance from the copied formula cell, as the cell references relative location to the original formula cell.


Use an Absolute Cell Reference
An absolute cell reference provides a permanent reference to a specific cell.When you copy a formula containing an absolute cell reference, the cell reference in the copied formula does not change, regardless of where you copy the formula. An absolute cell reference appears with a dollar sign before both the column letter and row number, such as $B$5.
Use a Mixed Cell Reference
A mixed cell reference combines an absolute cell reference with a relative cell reference.When you copy a formula containing a mixed cell reference, either the column letter or the row number that has the absolute reference remains fixed while the other part of the cell reference that is relative changes in the copied formula. $B5 and B$5 are examples of mixed cell references. In the reference $B5, the column B is absolute, and the row number is relative; when you copy the formula, the column letter, B, does not change, but the row number will change.
· Avoiding Circular References

If a formula contains a direct or an indirect reference to the cell containing the formula, a circular reference exists. For example, assume you enter the formula =A8-C8 in cell C8. Because the formula is in cell C8, using the cell address C8 within the formula creates a circular reference. Circular references usually cause inaccurate results, and Excel displays a warning message when you enter a formula containing a circular reference or when you open an Excel workbook that contains an existing circular reference

7. Function basics
An Excel function is a predefined computation that simplifies creating a complex calculation by using dialog boxes and ScreenTips to prompt you through selecting the values for the formula.
Function categories & descriptions
Compatibility: Contains functions compatible with Excel 2007 and earlier.
Cube: Returns values based on data in a cube, such as validating membership in a club, returning a member’s ranking, and displaying aggregated values from the club data set.
Database: Analyzes records stored in a database format in Excel and returns key values, such as the number of records, average value in a particular field, or the sum of values in a field.
Date & Time: Provides methods for manipulating date and time values.
Engineering: Calculates values commonly used by engineers, such as value conversions.
Financial: Performs financial calculations, such as payments, rates, present value, and future value.
Information: Provides information about the contents of a cell, typically displaying TRUE if the cell contains a particular data type such as a value.
Logical: Performs logical tests and returns the value of the tests. Includes logical operators for combined tests, such as AND, OR, and NOT.
Lookup & Reference: Looks up values, creates links to cells, or provides references to cells in a worksheet.
Math & Trig: Performs standard math and trigonometry calculations.
Statistical: Performs common statistical calculations, such as averages and standard deviations.
Text: Manipulates text strings, such as combining text or converting text to lowercase.

When using functions, you must adhere to correct syntax, the rules that dictate the structure and components required to perform the necessary calculations. 
The basic syntax of a function requires a function to start with an equal sign, to contain the function name, and to specify its arguments. The function name describes the purpose of the function. For example, the function name SUM indicates that the function sums or adds values.
A function’s arguments specify the inputs—such as cells or values—that are required to complete the operation. Arguments are enclosed in parentheses, with the opening parenthesis immediately following the function name. Some functions, such as TODAY, do not require arguments; however, you must include the parentheses with nothing inside them. In some cases, a function requires multiple arguments separated by commas.
· Inserting a Function
To insert a function by typing, first type an equal sign, and then begin typing the function name. Formula AutoComplete displays a list of functions and defined names that match letters as you type a formula. After you type the function name and opening parenthesis, Excel displays the function ScreenTip, a small pop-up description that displays the function’s arguments. The argument you are currently entering is bold in the function ScreenTip. Square brackets indicate optional arguments.
You can also use the Insert Function dialog box to search for a function, select a function category, and select a function from the list
· Totalling Values with the SUM Function

SUM function: totals values in two or more cells and then displays the result in the cell containing the function
The SUM function contains one required argument—number1—that represents a range of cells to add. The number2 optional argument is used when you want to sum nonadjacent cells or ranges, such as =SUM(A2:A14,F2:F14).
· Inserting Basic Statistical Functions

Find Central Tendency with the AVERAGE and MEDIAN Functions
People often describe data based on central tendency, which means that values tend to cluster around a central value. Excel provides two functions to calculate central tendency: AVERAGE and MEDIAN. 
The AVERAGE function calculates the arithmetic mean, or average, for the values in a range of cells.
The MEDIAN function finds the midpoint value, which is the value that one half of the population is above or below. The median is particularly useful because extreme values often influence arithmetic mean calculated by the AVERAGE function
Identify Low and High Values with MIN and MAX
The MIN function analyzes an argument list to determine the lowest value
The MAX function analyzes an argument list to determine the highest value, such as the highest score on a test. 
Like the MIN function, when the values in the range change, the MAX function will display the new highest value within the range of cells. 
Identify the Total Number with COUNT Functions
Excel provides three basic count functions, COUNT, COUNTBLANK, and COUNTA, to count the cells in a range that meet a particular criterion. 
The COUNT function tallies the number of cells in a range that contain values you can use in calculations, such as numerical and date data, but excludes blank cells or text entries from the tally. In Figure 12, the selected range spans 13 cells; however, the COUNT function returns 11, the number of cells that contain numerical data. It does not count the cell containing the text N/A or the blank cell.
The COUNTBLANK function tallies the number of cells in a range that are blank. The COUNTBLANK function identifies that one cell in the range A2:A14 is blank.
The COUNTA function tallies the number of cells in a range that are not blank, that is, cells that contain data whether a value, text, or a formula. In Figure 12, =COUNTA(A2:A14) returns 12, indicating the range A2:A14 contains 12 cells that contain some form of data. It does not count the blank cell.
Use Other Math and Statistical Functions
=ABS(number): Displays the absolute (i.e., positive) value of a number.
=FREQUENCY(data_array,bins_array): Counts how often values appear in a given range. 
=INT(number): Rounds a value number down to the nearest whole number.
=MODE.SNGL(number1,[number2],...): Displays the most frequently occurring value in a list.
=PI(): Returns the value of pi that is accurate up to 15 digits.
=PRODUCT(number1,[number2],...): Multiplies all values within the argument list.
=RANDBETWEEN(bottom,top): Generates a random number between two numbers you specify.
=RANK.AVG(number,ref,[order]): Identifies a value’s rank within a list of values; returns an average rank for identical values.
=RANK.EQ(number,ref,[order]): Identifies a value’s rank within a list of values; the top rank is identified for all
identical values.
=ROUND(number,num_digits): Rounds a value to a specific number of digits. Rounds numbers of 5 and greater up and those less than 5 down.
=SUMPRODUCT(array1,[array2],[array3],...): Finds the result of multiplying values in one range by the related values in
another column and then adding those products.
=TRIMMEAN(array,percent): Returns the arithmetic average of the internal values in a range by excluding a specified percentage of values at the upper and lower values in the data set. This function helps reduce the effect outliers (i.e., extreme values) have on the arithmetic mean.
=TRUNC(number,[num_digits]): Returns the integer equivalent of a number by truncating or removing the decimal or fractional part of the number. For example, =TRUNC(45.5) returns 45.
· Using Date Functions
Because Excel treats dates as serial numbers, you can perform calculations using dates
Insert the TODAY Function
The TODAY function displays the current date in a cell. Excel updates the function results when you open or print the workbook. The function is expressed as =TODAY(). The TODAY() function does not require arguments, but you must include the parentheses for the function to work.
Insert the NOW Function
The NOW function uses the computer’s clock to display the current date and time you last opened the workbook, so the value will change every time the workbook is opened.

8. Logical, Lookup, and Financial Functions

You will frequently use three function categories: logical, lookup and reference, and finance. 
Logical functions test the logic of a situation and return a particular result. 
Lookup and reference functions are useful when you need to look up a value in a list to identify the applicable value. 
Financial functions are useful to anyone who plans to take out a loan or invest money.
· Determining Results with the IF Function
The most common logical function is the IF function, which returns one value when a condition is met or is true and returns another value when the condition is not met or is false.
The IF function has three arguments: (1) a condition that is tested to determine if it is either true or false, (2) the resulting value if the condition is true, and (3) the resulting value if the condition is false
Design the Logical Test
The first argument for the IF function is the logical test. 
The logical test is a formula that contains either a value or an expression that evaluates to true or false. The logical expression is typically a binary expression, meaning that it requires a comparison between at least two variables
Design the Value_If_True and Value_If_False Arguments
The second and third arguments of an IF function are value_if_true and value_if_false.
When Excel evaluates the logical test, the result is either true or false. If the logical test evaluates to true, the value_if_true argument executes. If the logical test evaluates to false, the value_if_false argument executes. Only one of the last two arguments is executed; both arguments cannot be executed, since the logical test is either true or false but not both.
The value_if_true and value_if_false arguments can contain text, cell references, formulas, or constants
Nest Basic Functions as Arguments
A nested function occurs when one function is embedded as an argument within another function.
Nesting functions enables you to create more complex formulas to handle a variety of situations.
· Using Lookup Functions
You can use lookup and reference functions to look up values to perform calculations or display results
Create the Lookup Table
Before you insert lookup functions, you need to create a lookup table. 
A lookup table is a range containing a table of values or text that can be retrieved. The table should contain at least two rows and two columns, not including headings. It is important to plan the table so that it conforms to the way Excel can utilize the data within it.
You must arrange data from the lowest to the highest value and include only the lowest value in the range (such as 70) instead of the complete range. 
If the values you look up are exact values, you can arrange the first column in any logical order. 
The lowest value for a category or in a series is the breakpoint. The first column contains the breakpoints— such as 50, 70, and 80—or the lowest values to achieve a particular grade.
Understand the VLOOKUP Function Syntax 
The VLOOKUP function accepts a value, looks the value up in a vertical lookup table, and returns a result. Use VLOOKUP to search for exact matches or for the nearest value that is less than or equal to the search value, such as assigning an A grade for an 87% class average.
The VLOOKUP function has the following three required arguments and one optional argument:
(1) lookup_value, (2) table_array, (3) col_index_number, and (4) range_lookup.

The lookup value is the cell reference of the cell that contains the value to look up. The table array is the range that contains the lookup table: $A$3:$B$7. The table array range must be absolute and cannot include column labels for the lookup table. The column index number is the column number in the lookup table that contains the return values.
Understand How Excel Processes the Lookup
The VLOOKUP function identifies the value stored in the lookup value argument and then searches the first column of the lookup table until it finds an exact match (if possible). If Excel finds an exact match, it returns the value stored in the column designated by the column index number on that same row. If the table contains breakpoints for ranges rather than exact matches, Excel identifies the correct range based on comparing the lookup value to the breakpoints in the first column. If the lookup value is larger than the breakpoint, it looks to the next breakpoint to see if the lookup value is larger than that breakpoint also.When Excel detects that the lookup value is not greater than the next breakpoint, it stays on that row. It then uses the column index number to identify the column containing the value to return for the lookup value. Because Excel goes sequentially through the breakpoints, it is mandatory that the breakpoints are arranged from the lowest value to the highest value for ranges.
Instead of looking up values in a range, you can look up a value for an exact match using the optional range_lookup argument in the VLOOKUP function. By default, the range_lookup is set implicitly to TRUE, which is appropriate to look up values in a range.However, to look up an exact match, you must specify FALSE in the range_lookup argument. For example, if you are looking up product numbers, you must find an exact match to display the price. The function would look like this: VLOOKUP(D15,$A$1:$B$50,2,FALSE). The VLOOKUP function returns a value for the first lookup value that matches the first column of the lookup table. If no exact match is found, the function returns #N/A.
Use the HLOOKUP Function
You can design your lookup table horizontally, so that the first row contains the values for the basis of the lookup or the breakpoints, and additional rows contain data to be retrieved. With a horizontal lookup table, you must use the HLOOKUP function
The syntax is almost the same as the syntax for the VLOOKUP function, except the third argument is row_index_number instead of col_index_number
· Calculating Payments with the PMT Function
The PMT function calculates payments for a loan with a fixed amount at a fixed periodic rate for a fixed time period. The PMT function uses up to five arguments, three of which are required and two of which are optional: (1) rate, (2) nper, (3) pv, (4) fv, and (5) type.
The rate is the periodic interest rate, the interest rate per payment period.
The nper is the total number of payment periods (=how many times you will pay in all)
The pv is the present value of the loan. The result of the PMT function is a negative value because it represents your debt. However, you can display the result as a positive value by typing a minus sign in front of the present value cell reference in the PMT function.

9. Range names

To simplify entering ranges in formulas, you can use range names. 
A range name is a word or string of characters assigned to one or more cells.
· Creating and Maintaining Range Names
Each range name within a workbook must be unique.
Create a range name
A range name must begin with a letter or an underscore.
You can use a combination of upper- or lowercase letters, numbers, periods, and underscores throughout the range name. A range name cannot include spaces or special characters. You should create range names that describe the range of cells being named, but names cannot be identical to the cell contents. Keep the range names relatively short to make them easier to use in formulas.
You can edit or delete a range name. When you edit a range name, the formulas are updated automatically. 
Insert a Table of Range Names
Documentation is an important part of good spreadsheet design. People often document workbooks with date or time stamps that indicate the last date of revision, notes describing how to use a workbook, and so on. One way to document a workbook is to insert a list of range names in a worksheet
· Using Range Names in Formulas
You can use range names in formulas instead of cell references
Another benefit of using range names is that if you have to copy the formula, you do not have to make the cell reference absolute in the formula. Furthermore, if you share your workbook with others, range names in formulas help others understand what values are used in the calculations.

10. CHARTS- Depicting Data Visually

A chart is a visual representation of numerical data that compares data and helps reveal trends or patterns to help people make informed decisions. An effective chart depicts data in a clear, easy-to-interpret manner and contains enough data to be useful but not too much that the data overwhelm people.
· Deciding Which Chart Type to Create
The four most common chart types are column, bar, line, and pie.
You should organize the worksheet data before creating a chart by ensuring that the values in columns and rows are on the same value system (such as dollars or units) in order to make comparisons, that labels are descriptive, and that no blank rows or columns exist in the primary dataset.
A data point is a numeric value that describes a single value on a chart.
A data series is a group of related data points.
A category label is text that describes a collection of data points in a chart.
Create a Column Chart
A column chart displays data vertically in columns. You use column charts to compare values across different categories, such as comparing revenue among different cities or comparing quarterly revenue in one year. Column charts are most effective when they are limited to small numbers of categories—generally seven or fewer.
The chart area contains the entire chart and all of its elements, including the plot area, titles, legend, and labels. 
The plot area is the region containing the graphical representation of the values in the data series. Two axes form a border around the plot area. 
The X-axis is a horizontal border that provides a frame of reference for measuring data horizontally. 
The Y-axis is a vertical border that provides a frame of reference for measuring data vertically. 
Excel refers to the axes as the category axis and value axis. 
The category axis displays descriptive group names or labels, such as college names or cities, to identify data. 
The value axis displays incremental numbers to identify approximate values, such as dollars or units, of data points in the chart. In a column chart, the category axis is the X-axis, and the value axis is the
Y-axis.
A single data series compares values for one set of data.
A multiple data series compares two or more sets of data in one chart.
A clustered column chart compares groups or clusters of columns set side-by-side for easy comparison. The clustered column chart facilitates quick comparisons across data series, and it is effective for comparing several data points among categories
A legend is a key that identifies the colour, gradient, picture, texture, or pattern assigned to each data series in a chart.
A stacked column chart shows the relationship of individual data points to the whole category.
a stacked column chart displays only one column for each category. Each category within the stacked column is colour-coded for one data series. Use the stacked column chart when you want to compare total values across categories, as well as to display the individual category values. When you create a stacked column chart, you must ensure data are additive, meaning that each column represents a sum of the data for each segment
A 100% stacked column chart compares the percentage each data point contributes to the total for each category. Similar to the stacked column chart, the 100% stacked column chart displays only one column per category. The value axis displays percentages rather than values, and all columns are the same height: 100%.Use this type of chart when you are more interested in comparing relative percentage contributions across categories rather than actual values across categories.
A 3-D chart adds a third dimension to each data series; the third dimension does not plot another value. Usually not a good idea to use this effect. 
Create a Bar Chart
A bar chart compares values across categories using horizontal bars. In a bar chart, the horizontal axis displays values, and the vertical axis displays categories. A bar chart conveys the same type of information as a column chart; however, a bar chart is preferable when category names are long, such as Humanities & Social Science. A bar chart enables category names to appear in an easy-to-read format, whereas a column chart might display category names at an awkward angle or smaller font size.
Create a Line Chart
A line chart displays lines connecting data points to show trends over equal time periods, such as months, quarters, years, or decades.With multiple data series, Excel displays each data series with a different line colour. The category axis (X-axis) represents time, such as ten-year increments, whereas the value axis (Y-axis) represents the value, such as a monetary value or quantity. A line chart enables a user to easily spot trends in the data since the line continues to the next data point. The line, stacked, and 100% stacked line charts do not have specific indicators for each data point. To show each data point, select Line with Markers, Stacked Line with Markers, or 100% Stacked Line with Markers.
Create a Pie Chart
A pie chart shows each data point as a proportion to the whole data series. The pie chart displays as a circle or “pie,”where the entire pie represents the total value of the data series. Each slice represents a single data point. The larger the slice, the larger percentage that data point contributes to the whole. Use a pie chart when you want to convey percentage or market share. Unlike column, bar, and line charts, pie charts represent a single data series only. Limit it to 7 slices
Create Other Chart Types
Excel enables you to create seven other basic chart types: area, X Y (scatter), stock, surface, doughnut, bubble, and radar. Each chart type has many chart subtypes available. An area chart is similar to a line chart in that it shows trends over time. Like the line chart, the area chart uses continuous lines to connect data points. The difference between a line chart and an area chart is that the area chart displays colours between the lines. People sometimes view area charts as making the data series more distinguishable because of the filled-in colours.
An X Y (scatter) chart shows a relationship between two variables using their X and Y coordinates. Excel plots one variable on the horizontal X-axis and the other variable on the vertical Y-axis. Scatter charts are often used to represent data in educational, scientific, and medical experiments. A scatter chart is essentially the plotted values without any connecting line. A scatter chart helps you determine if a relationship exists between two different sets of numerical data.
Stock charts show fluctuations in stock changes. You can select one of four stock subtypes: High-Low-Close, Open-High-Low-Close, Volume-High-Low-Close, and Volume- Open-High-Low-Close. The High-Low-Close stock chart marks a stock’s trading range on a given day with a vertical line from the lowest to the highest stock prices. Horizontal bars or rectangles mark the opening and closing prices. Although stock charts may have some other uses, such as showing a range of temperatures over time, they usually show stock prices. To create an Open-High-Low-Close stock chart, you must arrange data with Opening Price,
High Price, Low Price, and Closing Price as column labels in that sequence. If you want to create other variations of stock charts, you must arrange data in a structured sequence required by Excel.
The surface chart is similar to a line chart; however, it represents numeric data and numeric categories. This chart type takes on some of the same characteristics as a topographic map of hills and valleys. Excel fills in all data points with colours. Surface charts are not as common as other chart types because they require more data points and often confuse people
The doughnut chart is similar to a pie chart in that it shows the relationship of parts to a whole, but the doughnut chart can display more than one series of data, and it has a hole in the middle. Like a clustered or stacked column chart, a doughnut chart plots multiple data series. Each ring represents a data series, with the outer ring receiving the most emphasis. Although the doughnut chart is able to display multiple data series, people often have difficulty interpreting it.
The bubble chart is similar to a scatter chart, but it uses round bubbles instead of data points to represent a third dimension. Similar to the scatter chart, the bubble chart does not contain a category axis. The horizontal and vertical axes are both value axes. The third value determines the size of the bubble where the larger the value, the larger the bubble. People often use bubble charts to depict financial data. 
When creating a bubble chart, do not select the column headings, as they might distort the data.
The radar chart uses each category as a spoke radiating from the centre point to the outer edges of the chart. Each spoke represents each data series, and lines connect the data points between spokes, similar to a spider web. You can create a radar chart to compare aggregate values for several data series.
· Creating a Chart
Select the Data Source
Identify the chart data range by selecting the data series, any descriptive labels you need to construct the category labels, and the series labels you need to create the legend. Edit the row and column labels if they are not clear and concise.
Data selection for charts
Column, Bar, Line, Area, Doughnut Row labels (such as colleges), column labels (such as years), and one or more data series ( EX: A4:E11)
Pie Row labels (such as colleges) and only one data series (such as 2012), but not column headings (EX: A5:A11,E5:E11)
Bubble Three different data series (such as age, years, and salary) (EX: A21:C26)
X Y (Scatter) Two related numeric datasets (such as minutes studying and test scores)
Select the Chart Type
After you select the range of cells that you want to be the source for the chart, you need to select the chart type.
Excel inserts the chart as an embedded object on the current worksheet. You can leave the chart on the same worksheet as the worksheet data used to create the chart, or you can place the chart in a separate worksheet, called a chart sheet. A chart sheet contains a single chart only; you cannot enter data and formulas on a chart sheet. If you leave the chart in the same worksheet, you can print the data and chart on the same page. If you want to print or view a full-sized chart, you can move the chart to its own chart sheet.
Position and size the chart
When you first create a chart, Excel inserts the chart in the worksheet, often to the right side of, but sometimes on top of and covering up, the data area. You can move its location.  A sizing handle, indicated by faint dots on the outside border of a selected chart, enables you to adjust the size of the chart.
11. Chart Design
When you select a chart, Excel displays the Chart Tools contextual tab. That tab contains three specific tabs: Design, Layout, and Format.
The Chart Tools Design contextual tab contains options to modify the overall chart design. You can change the chart type, modify the data source, select a chart layout, select a chart style, and move the chart
The Design tab provides commands for specifying the structure of a chart. Specifically, you can change the chart type and change the data source to build the chart. In addition, you can specify a chart layout that controls which chart elements display and where, select a chart style, and move the chart to a different location
· Changing the Chart Type
Changing the Data Source and Structure
By default, Excel displays the row labels in the first column on the category axis and the column labels (such as years) as the data series and in the legend. You can reverse how the chart presents the data
Applying a Chart Layout and a Chart Style
The Chart Layouts group enables you to apply predefined layouts to a chart. A chart layout determines which chart elements appear in the chart area and how they are positioned within the chart area.
The Chart Styles group contains predefined styles that control the colour of the chart area, plot area, and data series.
Moving a Chart
By default, Excel creates charts on the same worksheet as the original dataset, but you can move the chart to its own chart sheet in the workbook.
Printing Charts
Just like for printing any worksheet data, preview the chart in the Backstage view before you print to check margins, spacing, and page breaks to ensure a balanced printout.
Print an Embedded Chart
If you embedded a chart on the same sheet as the data source, you need to decide if you want to print the data only, the data and the chart, or the chart only.
Print a Chart Sheet
If you moved the chart to a chart sheet, the chart is the only item on that worksheet. The default setting is print active sheet, and the chart will print as a full-page chart
· Inserting and Customizing a Sparkline
Excel 2010 enables you to create miniature charts called sparklines. A sparkline is a small line, column, or win/loss chart contained in a single cell. The purpose of a sparkline is to present a condensed, simple, succinct visual illustration of data.Unlike a regular chart, a sparkline does not include a chart title or axes labels. Inserting sparklines next to data helps your audience understand data quickly without having to look at a full-scale chart.
Apply Design Characteristics to a Sparkline
After you insert a sparkline, the Sparkline Tools Design contextual tab displays, with options to customize the sparkline
The Show group enables you to display points within the sparkline. For example, click the Markers check box to display markers for all data points on the sparkline, or click High Point to display a marker for the high point, such as for the highest sales or highest price per litre of gasoline for a time period. 
The Style group enables you to change the sparkline style, similar to how you can apply different chart styles to charts. Click Sparkline Color to change the colour of the sparkline. Click Marker Color, point to a marker type—such as High Point—and then click the colour for that marker. Make sure the marker colour contrasts with the sparkline colour.
12. Chart Layout
The Chart Tools Layout tab enables you to enhance your charts by selecting specific chart elements, inserting objects, displaying or removing chart elements, customizing the axes, formatting the background, and including analysis. When adding visual elements to a chart, make sure these elements enhance the effectiveness of the chart instead of overpowering it.
· Selecting and Formatting Chart Elements
A chart includes several elements—the chart area, the plot area, data series, the horizontal axis, the vertical axis, and the legend—each of which you can customize
After you select a chart element, you can format it and change its settings. You can apply font settings, such as increasing the font size, from the Font group on the Home tab. You can format the values by applying a number style or by changing the number of decimal places on the value axis using the options in the Number group on the Home tab. You can apply multiple settings at once using a Format dialog box, such as Format Data Series.
· Customizing Chart Labels
You should include appropriate labels to describe chart elements
Insert and Format the Chart Title
A chart title is the label that describes the entire chart. Chart titles should reflect the purpose of the chart
Excel does not include a chart title by default
· None. Removes a chart title from the current chart.
· Centered Overlay Title. Centres the chart title horizontally without resizing the chart; the title appears over the top of the chart.
· Above Chart. Centres the title above the chart, decreasing the chart size to make room for the chart title.
· [bookmark: _GoBack]More Title Options. Opens the Format Chart Title dialog box so that you can apply fill, border, and alignment settings.
Position and Format the Axis Titles
Axis titles are labels that describe the category and value axes. If the names on the category axis are not self-explanatory, you can add a label to describe it. The value axis often needs further explanation, such as In Millions of Dollars to describe the unit of measurement.
· None. Removes the horizontal axis title from the current chart.
· Title Below Axis. Displays the horizontal axis title below the category axis.
· More Primary Horizontal Axis Title Options. Opens the Format Axis Title dialog box so that you can apply fill, border, and alignment settings.

· None. Removes the value axis title from the current chart.
· Rotated Title. Displays the value axis title on the left side of the value axis, rotated vertically. The chart in Figure 42 uses the Rotated Title setting.
· Vertical Title. Displays the vertical axis title on the left side of the value axis, with the letters in the title appearing vertically down the left edge.
· Horizontal Title. Displays the vertical axis title on the left side of the value axis; the title consumes more horizontal space.
· More Primary Vertical Axis Title Options. Opens the Format Axis Title dialog box so that you can apply fill, border, and alignment settings.
Customize the Legend
When you create a multiple series chart, the legend appears on the right side of the plot area
You can apply a background fill colour, display a border around the legend, select a border colour or line style, and apply a shadow effect. Remove the legend if it duplicates data found elsewhere in the chart.
Insert and Format Data Labels
Data labels are descriptive labels that show the exact value of the data points on the value axis.
Only add data labels when they are necessary for a specific data series; adding data labels for every data point will clutter the chart.
The Format Data Labels dialog box enables you to specify what to display as the label. The default Label Contains setting displays values, but you can display additional data such as the category name. Displaying additional data can clutter the chart. You can also specify the position of the label, such as Center or Outside End. If the numeric data labels are not formatted, click Number on the left side of the dialog box, and then apply number formats.
Include and Format a Data Table
A data table is a grid that contains the data source values and labels. If you embed a chart on the same worksheet as the data source, you do not need to include a data table. Only add a data table with a chart to a chart sheet if you need the audience to know the exact values.
· Formatting the Axes and Gridlines
Based on the data source values and structure, Excel determines the starting, incremental, and stopping values that display on the value axis when you create the chart.You might want to adjust the value axis. For example, when working with large values such as 4,567,890, the value axis displays increments, such as 4,000,000 and 5,000,000. You can simplify the value axis by displaying values in millions, so that the values on the axis are 4 and 5 with the word Millions placed by the value axis to indicate the units
Gridlines are horizontal or vertical lines that span across the chart to help people identify the values plotted by the visual elements, such as a column. Excel displays horizontal gridlines for column, line, scatter, stock, surface, and bubble charts and vertical gridlines for bar charts.
· Adding a Trendline
Charts help reveal trends, patterns, and other tendencies that are difficult to identify by looking at values in a worksheet. A trendline is a line that depicts trends or helps forecast future data. Trendlines are commonly used in prediction, such as to determine the future trends of sales, or the success rate of a new prescription drug. You can use trendlines in unstacked column, bar, line, stock, scatter, and bubble charts.
Linear Trendline, Exponential Trendline, Linear Forecast Trendline, or Two Period Moving Average

13. DATASETS AND TABLES-  Managing Large Volumes of Data
Large Datasets
· Freezing Rows and Columns
When you scroll to parts of a dataset not initially visible, some rows and columns disappear from view.When the row and column labels scroll off the screen, you may not remember what each column represents.You can keep labels onscreen by freezing them. Freezing is the process of keeping rows and/or columns visible onscreen at all times even when you scroll through a large dataset.
Freeze Panes Keeps both rows and columns above and to the left of the active cell visible as you scroll through a worksheet.
Freeze Top Row Keeps only the top row visible as you scroll through a worksheet. 
Freeze First Column Keeps only the first column visible as you scroll through a worksheet.
· Printing Large Datasets
Manage Page Breaks
Based on the paper size, orientation, margins, and other settings, Excel identifies how much data can print on a page. Then it displays a page break, indicating where data will start on another printed page. You can adjust the page breaks. Blue dashed lines indicate where the automatic page breaks occur, and solid blue lines indicate manual page breaks.
Set and Clear a Print Area
The default settings send an entire dataset on the active worksheet to the printer. However, you might want to print only part of the worksheet data. For example, you might want to print an input area only or transactions that occurred on a particular date. You can set the print area, which is the range of cells that will print.
Print Titles
When you print large worksheets, make sure every column and row contains descriptive labels on each page. Having the column and row labels print on only the first page does not help your audience identify data on subsequent pages.
Control Print Page Order
Print order is the sequence in which the pages are printed. By default, the pages print in this order: top-left section, bottom-left section, top-right section, and bottom-right section. However, you might want to print the entire top portion of the worksheet before printing the bottom portion
14. Excel Tables

A table is a structured range that contains related data organized in such a way as to facilitate data management and analysis. Although you can manage and analyze a range of data, a table provides many advantages over a range of data:
• Column headings that remain onscreen during scrolling without having to use Freeze Panes
• Filter lists for efficient sorting and filtering
• Predefined table styles to format table rows and columns with complementary fill colours
• Ability to create and edit calculated columns where the formulas copy down the columns automatically
• Calculated total row enabling the user to choose from a variety of functions
• Use of structured references instead of cell references in formulas
• Ability to export the table data to a SharePoint list
· Understanding Table Design
An Excel table is like a database table: It provides a structured organization of data in columns and rows. Each column represents a field, which is an individual piece of data, such as last names or quantities sold. You should create fields with the least amount of data. For example, instead of a Name field, separate data into First Name and Last Name fields. Instead of one large address field, separate addresses into Street Address, City, Province, and Postal Code fields. Storing data into the smallest units possible enables you to manipulate the data in a variety of ways for output.
Each row in an Excel table represents a record, which is a collection of data about one entity, such as data for one person. For example, your record in your professor’s grade book contains specific data about you, such as your name, ID, test scores, etc. The professor maintains a record of similar data for each student in the class. In an Excel table, each cell represent one piece of data (in the respective field columns) for a particular record.
Often, people create tables from existing worksheet data. Just as you spend time planning a worksheet, you should plan the structure for a table. Think about who will use the table, what types of reports you need to produce, and what types of searches might be done. The more thorough your planning process, the fewer changes you will have to make to the table after you create it

· Enter field names on the top row.
· Keep field names relatively short, descriptive, and unique. No two field names should be identical.
· Format the field names so that they stand out from the data.
· Enter data for each record on a row below the field names.
· Do not leave blank rows between records or between the field names and the first record.
· Delete any blank columns between fields in the dataset.
· Make sure each record has something unique about it, such as a transaction number or ID.
· Insert at least one blank row and one blank column between the table and other data, such as the main titles, input area, or other tables. When possible, place separate tables on separate worksheets
· Creating a table
You can create a table from existing data; If you do not have existing data, you can create a table structure, and then add data to it later.
Add, Edit, and Delete Records
After you create a table, you will need to maintain it, such as by adding new records. For example, you might need to add a new client or employee record, or add a new item to an inventory table or transaction table. You can also edit and delete records in the same way. 
Add and Delete Fields
Even if you carefully plan the fields for a table, you might decide to add new fields.
You can also delete a field if you no longer need any data for that particular field. Although deleting records and fields is easy, you must make sure not to delete data erroneously
Remove Duplicate Rows
You might accidentally enter duplicate records in a table, which can give false results when totalling or performing other calculations on the dataset. For a small table, you might be able to detect duplicate records by scanning the data. For large tables, it is more difficult to identify duplicate records by simply scanning the table with the eye.
· Applying a Table Style
Formatting tables can make them more attractive and easier to read, and can emphasize data. The Design tab provides a variety of formatting options for tables. Excel applies a table style when you create a table. Table styles: control the fill colour of the header row (the row containing field names) and rows of records. In addition, table styles specify bold and border lines. You can change the table style to a colour scheme that complements your organization’s colour scheme or to emphasize data in the table
Header Row: Displays the header row (field names) when checked; removes field names when not checked. Header Row formatting takes priority over column formats.
Total Row: Displays a total row when selected. Total Row formatting takes priority over column formats.
First Column: Applies a different format to the first column so that the row headings stand out. First Column formatting takes priority over Banded Rows formatting.
Last Column: Applies a different format to the last column so that the last column of data stands out; effective for aggregated data, such as grand totals, per row. Last Column formatting takes priority over Banded Rows formatting.
Banded Rows: Displays alternate fill colours for even and odd rows to help distinguish records.
Banded Columns: Displays alternate fill colours for even and odd columns to help distinguish fields.
15. Table Manipulation and Aggregation
· Sorting Data
Sorting arranges records by the value of one or more fields within a table.
Sort One Column
You can sort data by one or more columns
When you format data as a table, the field names appear in a header row, which contains sort and filter arrows.

Text Sort A to Z Arranges data in alphabetical order.
        Sort Z to A Arranges data in reverse alphabetical order.
Dates Sort Oldest to Newest Displays data in chronological order, from oldest to newest.
          Sort Newest to Oldest Displays data in reverse chronological order, from newest to oldest.
Values Sort Smallest to Largest Arranges values from the smallest value to the largest value.
            Sort Largest to Smallest Arranges values from the largest value to the smallest value.
Use the Sort Dialog Box to Sort Multiple Columns
At times sorting by only one field yields several records that have the same information—for example, the same last name or the same manufacturer. Sales representative names and manufacturer names appear several times. A single sort field does not uniquely identify a record. You might need both last name and first name to identify an individual. Using multiple level sorts allows differentiation among records with the same data in the first (primary) sort level. For example, you might want to sort by sales rep names, manufacturer, and then by price
Create a Custom Sort
Excel arranges data in defined sequences, such as alphabetical order. For example, weekdays are sorted alphabetically: Friday, Monday, Saturday, Sunday, Thursday, Tuesday, and Wednesday. However, you might want to create a custom sort sequence. For example, you can create a custom sort to arrange weekdays in order from Sunday to Saturday.
· Filtering Data
You might want to show only particular records. Filtering is the process of specifying conditions to display only those records that meet certain conditions. Often you will need to apply more than one filter to display the needed records. You can filter more than one column. Each additional filter is based on the current filtered data and further reduces a data subset
Apply Text Filters
The other records are hidden but not deleted. The filter arrow displays a filter icon, indicating which column is filtered. Excel displays the row numbers in blue, indicating that you applied a filter. The missing row numbers indicate hidden rows of data. When you remove the filter, all the records display again
Apply Number Filters
When you filter a column of numbers, you can select specific numbers. You might want to filter numbers by a range, such as numbers greater than $5,000 or numbers between $4,000 and $5,000. The submenu enables you to set a variety of number filters.
Apply Date Filters
When you filter a column of dates, you can select specific dates or a date range, such as dates after 1/15/2012 or dates between 1/1/2012 and 1/7/2012. The submenu enables you to set a variety of date filters
Apply a Custom Filter
If you select options such as Greater Than or Before, Excel displays the Custom AutoFilter dialog box. You can also select Custom Filter from the menu to display this dialog box, which is designed for more complex filtering requirements
You can use wildcards to represent characters. For example, to select all provinces starting with New, type New * in the second box. The asterisk (*) represents any number of characters. If you want a wildcard for only a single character, type the question mark (?).
Clear Filters
After reviewing the filtered data, you can remove the filters to see the entire dataset again. Excel then removes that column’s filter and displays records previously hidden by that filter. You can also delete all filters. 
· Using Structured References and a Total Row
Although you can create complex formulas that you understand, you should strive to create formulas that other people can understand. Creating easy-to-read formulas helps you present self-documenting formulas that require less explanation on your part.
When you create formulas for tables, you can use built-in functionality (such as structured references and a total row) that assists you in building understandable formulas.
Create Structured References in Formulas
Your experience in building formulas involves using cell references, such as =SUM(B1:B15) or =H6*$B$3, or range names, such as grades in =VLOOKUP(E5,grades,2). You can use cell references and range names in formulas to perform calculations in a table, as well as another type of reference for formulas in tables: structured references. A structured reference is a tag or use of a table element, such as a column heading, as a reference in a formula. Structured references in formulas clearly indicate what type of data is used in the calculations. A structured reference requires brackets around column headings or field names, such as =[Amount]-[Down Payment]. The use of column headings without row references in a structured formula is called an unqualified reference. While creating a formula by typing, Formula AutoComplete displays a list of column headings after you type the equal sign and the opening bracket (see Figure 28). Type or double-click the name from the list, and then type the closing bracket. Excel displays a coloured border around the column being referenced. When you enter a formula using structured references, Excel copies the formula down the rest of the column in the table automatically, compared to typing references in formulas and copying the formula down a column.
You can still use the semi-selection process to create a formula. If you use the pointing process to enter a formula in a table, Excel builds a formula like this: =[@Amount]-[@Down Payment], where the @ indicates the current row. If you use the semi-selection process to create a formula outside the table, the formula includes the table name and row as well, such as =Table1[@Amount]-Table1[@Down Payment]. Table1 is the name of the table, and Amount and Down Payment are column headings. This structured formula that includes references, such as table numbers, is called a fully qualified reference. When you build formulas within a table, you can use either unqualified or fully qualified structured references. If you need to use table data in a formula outside the table boundaries, you must use fully qualified structured references.
Create a Total Row
Aggregating data provides more meaningful quantitative interpretation than individual values at times. For regular ranges of data, you use basic statistical functions, such as SUM, AVERAGE, MIN, and MAX, to provide meaning for a dataset. An Excel table provides the advantage of being able to display a total row automatically without creating the aggregate function yourself. A total row appears below the last row of records in an Excel table and enables you to display summary statistics, such as a sum of values displayed in a column
The SUBTOTAL function calculates results on the total row. The SUBTOTAL function calculates an aggregate value, such as totals, for values in a range or database.

16. Conditional formatting
Conditional formatting applies special formatting to highlight or emphasize cells that meet specific conditions
· Applying Conditional Formatting
Conditional formatting helps you and your audience understand a dataset better because it adds a visual element to the cells. The term is called conditional because the formatting occurs when a condition is met.
· Highlight Cells Rules Highlights cells with a fill colour, font colour, or border (such as Light Red Fill with Dark Red Text) if values are greater than, less than, between two values, equal to a value, or duplicate values; text that contains particular characters; or dates when a date meets a particular condition, such as In the last 7 days.
· Top/Bottom Rules Formats cells with values in the top 10 items, top 10%, bottom 10 items, bottom 10%, values, above average, or below average. You can change the exact values to format the top or bottom items or percentages, such as top 5 or bottom 15%. 
· Data Bars Applies a gradient or solid fill bar in which the width of the bar represents the current cell’s value compared to other cells’ values. 
· Color Scales Formats different cells with different colours, assigning one colour to the lowest group of values and another colour to the highest group of values, with gradient colours to other values.
· Icon Sets Inserts an icon from an icon palette in each cell to indicate values compared to each other.
Apply the Highlight Cells Rules
The Highlight Cells Rules category enables you to apply a highlight to cells that meet a condition, such as a value greater than a particular value. This option contains predefined combinations of fill colours, font colours, and/or borders. This category is useful because it helps you identify and format automatically values of interest
Specify Top/Bottom Rules
You may not know the exact values to format conditionally. You might be interested in identifying the top five sales to reward the sales associates, or want to identify the bottom 15% of automobile dealers so that you can close underperforming locations. The Top/Bottom Rules category enables you to specify the top or bottom number or percentage in a selected range. In addition, the Top/Bottom Rules category enables you to identify values that are above or below the average value in that range
Display Data Bars, Color Scales, and Icon Sets
Data bars help you visualize the value of a cell relative to other cells. The width of the gradient or solid data bar represents the value in a cell, with a wider bar representing a higher value and a shorter bar a lower value. Use data bar conditional formatting when identifying high and low values. Excel locates the largest value and displays the widest data bar in that cell. Excel then finds the smallest value and displays the smallest data bar in that cell. Excel sizes the data bars for the remaining cells based on their relative values. If you change the values in your worksheet, Excel automatically updates the widths of the data bars. Data bars are more effective with wider columns than narrow columns.
Color scales format cells with different colours based on the relative value of a cell compared to other selected cells. You can apply a two- or three-colour scale. This scale assists in comparing a range of cells using gradations of those colours. The shade of the colour represents higher or lower values. Use colour scales to understand variation in the data to identify trends, for example to view good stock returns and weak stock returns. 
Icon sets are little symbols or signs that display in cells to classify data into three, four, or five categories, based on the values in the selected range. Excel determines categories of value ranges and assigns an icon to each range.
You can clear conditional formatting from the worksheet
· Creating a New Rule
The default conditional formatting categories provide a variety of options. Excel also enables you to create your own rules to specify different fill colours, borders, or other formatting if you don’t want the default settings.
Use Formulas in Conditional Formatting
Excel provides a vast number of conditional formatting options. If you need to create a complex conditional formatting rule, you can select a rule that uses a formula to format cells.
To create a formula-based conditional formatting rule, select the data and create a new rule.
Manage Rules
You can edit or delete conditional formatting rules
You can sort and filter by conditional formatting as well.
